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1  Informations relatives au document

1.1  Fonction du document
Le présent manuel de mise en service contient toutes les informations nécessaires à
l'utilisation du logiciel : de la description du produit, de l'installation et l'utilisation aux
mises à jour du logiciel et à la mise au rebut en passant par l'intégration système, la
configuration, le diagnostic et le dépannage.

1.2  Symboles

1.2.1  Symboles d'avertissement

Symbole Signification

DANGER

DANGER !
Cette remarque attire l'attention sur une situation dangereuse qui, lorsqu'elle n'est
pas évitée, entraîne la mort ou des blessures corporelles graves.

AVERTISSEMENT

AVERTISSEMENT !
Cette remarque attire l'attention sur une situation dangereuse qui, lorsqu'elle n'est
pas évitée, peut entraîner la mort ou des blessures corporelles graves.

ATTENTION

ATTENTION !
Cette remarque attire l'attention sur une situation dangereuse qui, lorsqu'elle n'est
pas évitée, peut entraîner des blessures corporelles de gravité légère ou moyene.

AVIS

AVIS !
Cette remarque contient des informations relatives à des procédures et éléments
complémentaires, qui n'entraînent pas de blessures corporelles.

1.2.2  Symboles pour les types d'informations

Symbole Signification

Autorisé
Procédures, processus ou actions autorisés

A privilégier
Procédures, processus ou actions à privilégier

Interdit
Procédures, processus ou actions interdits

Conseil
Indique la présence d'informations complémentaires.

Renvoi à la documentation

A Renvoi à la page

Renvoi au schéma

Remarque ou étape individuelle à respecter

1. , 2. , 3.… Etapes de manipulation

Résultat d'une étape

Aide en cas de problème

Contrôle visuel
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1.2.3  Symboles FieldCare

Symbole Signification

Démarrer un nouveau projet.

Ouvrir un projet existant.

Enregistrer un projet ouvert.

Imprimer un projet ouvert.

Ouvrir le Presse-papiers.

Affichage du catalogue DTM.

Ouvrir la documentation pour l'appareil sélectionné ou les informations détaillées sur l'appareil.

Ouvrir l'inventaire.

Activer le protocole.

Ajouter un nouvel appareil au réseau.

Supprimer l'appareil du réseau.

Créer une nouvelle topologie de réseau à l'aide de CommDTM et de DeviceDTM.

Compare la topologie du réseau sur le terrain avec le réseau physique réel, et les appareils sont
ajoutés au réseau existant.

Analyse la topologie préconfigurée et affiche le rapport avec les informations de l'appareil analysé.

Indique l'existence d'une connexion avec l'appareil.

Transférer les informations à partir de l'appareil vers FieldCare.

Transférer les informations à partir de FieldCare vers l'appareil.

Fonctions spécifiques à l'appareil sélectionné.

Ajouter un niveau d'installation.

Ajouter un élément.

Supprimer un niveau d'installation.

Supprimer un élément.

Ouvrir la liste de contrôle d'appareil afin d'afficher les appareils sélectionnés dans l'installation.

Confirmer l'appareil remplacé.

Déconnecté.  1)
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Symbole Signification

Établir la communication, prêt pour la communication.  1)

Canal de communication occupé ou action de communication annulée. 1)

Connecté.  1)

Le symbole W@M apparaît en bas à droite dans la barre de démarrage lorsqu'une connexion W@M a
été établie.

Activer le mode tactile.

Désactiver le mode tactile.

1) Indicateur d'état : indication d'état en ligne/hors ligne des appareils dans la vue Installation et Réseau

1.3  Mise en évidence du texte

Mise en évidence Signification Exemple

Gras Touches, boutons, icônes programme,
onglets, menus, commandes

Start → Programs → Endress+Hauser
Dans le menu File, sélectionner l'option Print.

Crochets Variables <lecteur DVD>

1.4  Acronymes utilisés

Acronymes Signification

APL Advanced Physical Layer (Couche physique avancée)

CSV Comma Separated Value (Valeurs séparées par des virgules)

DTM Device Type Manager (Pilote pour les appareils)

FDI Field Device Integration (Intégration des appareils de terrain)

FDT Field Device Tool

HART Highway Addressable Remote Transducer

I/O Entrée/sortie

IO-Link Nom de marque d'un système de communication comprenant des capteurs et des actionneurs
intelligents

IODD IO Device Description (Description d'appareils électroniques)

IP Internet Protocol (Protocole Internet)

PROFIBUS Process Field Bus

PROFINET Process Field Network

SLM Software License Management (Gestion des licences logicielles)

TCP Transmission Control Protocol (Protocole TCP)

UDP User Datagram Protocol (Protocole UDP)

URL Uniform Resource Locator

W@M Web Enabled Asset Management (Gestion en ligne des actifs)
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1.5  Documentation
FieldCare SFE500
• Guide de démarrage KA01303S/04/A2
• Tutoriel pour projets FieldCare SD01928S/04/EN
• Information technique TI00028S/04/FR

1.6  Marques déposées
PROFINET® est une marque déposée de la PROFIBUS Nutzorganisation e.V. (PROFIBUS
User Organization), Karlsruhe/Allemagne.

PROFIBUS® est une marque déposée de la PROFIBUS Nutzorganisation e.V. (PROFIBUS
User Organization), Karlsruhe/Allemagne.

IO-Link® est une marque déposée par le IO-Link Consortium/IO-Link Community c/o
PROFIBUS Nutzerorganisation e.V. (PNO) Karlsruhe/ Allemagne

FOUNDATIONTM Fieldbus est une marque déposée du FieldComm Group, Austin, TX
78759, USA.

HART®, WirelessHART® est une marque déposée du FieldComm Group, Austin, TX 78759,
USA.

Ethernet/IP est la marque déposée par l'ODVA, Michigan USA.

Modbus® est une marque déposée par l'organisation Modbus, Hopkinton, USA

Toutes les autres marques et tous les autres noms de produit sont des marques déposées
par les sociétés ou organisations concernées.
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2  Consignes de sécurité de base

2.1  Exigences imposées au personnel
L'accès physique et électronique aux appareils, réseaux, ordinateurs et systèmes de terrain
doit être limité à un groupe autorisé de personnes. Par conséquent, un système d'accès
basé sur les rôles doit être utilisé. Établir des directives et procédures détaillées afin de ne
permettre l'accès au PC ou autre équipement qu'à des personnes autorisées.

2.2  Utilisation conforme
FieldCare est un outil de gestion des actifs basé sur FDT (Field Device Tool) qui, en fonction
de la version, peut être utilisé pour la configuration des appareils, la gestion des
instruments ou la surveillance d'état. Grâce à l'utilisation des pilotes Device Type Manager
(DTM) appropriés, il est en mesure de faire fonctionner les appareils de terrain et les
composants du système indépendamment du protocole de communication.

Un pare-feu correctement configuré doit être utilisé, celui-ci devant bloquer toutes les
données qui ne répondent pas aux spécifications de sécurité. Pour accroître davantage la
sécurité, les ports qui ne sont pas utilisés doivent être désactivés et un système de
détection de zone démilitarisée ou d'intrusion doit être utilisé. Une gestion des patches en
temps réel doit être mise en place pour tous les produits, comme les systèmes
d'exploitation, les navigateurs Internet, les programmes, les apps, les bases de données et
les pilotes. De même, un logiciel antivirus doit être utilisé sur le PC. Les matériels, les
logiciels, les firmware et tout autre contenu électronique ne devraient être utilisés que s'ils
proviennent de sources fiables.

Il est recommandé d'utiliser des mots de passe sûrs pour l'accès électronique aux
programmes, p. ex. pour le PC, FieldCare, SQL Server et les appareils de terrain :
• Le mot de passe doit comporter au moins 8 caractères
• Ne pas utiliser de nom d'utilisateur, de nom ou de nom d'entreprise
• Il ne doit pas contenir un mot complet
• Il doit être très différent des mots de passe précédents
• Il doit être composé de lettres majuscules, de lettres minuscules, d'un chiffre et d'un

symbole
• Il doit être changé régulièrement

2.3  Sécurité du produit
DEP – Prévention d’exécution des données
La prévention d’exécution des données (DEP – "Data Execution Prevention") est un outil de
sécurité qui aide à prévenir des virus, des dommages et des menaces de sécurité de votre
ordinateur. En surveillant les programmes, la prévention d’exécution des données peut
aider à protéger l'ordinateur et s'assurer que les applications utilisent la mémoire système
en toute sécurité. Dès qu'une application tente d'accéder à un programme, la prévention
d’exécution des données ferme le programme.

Configuration de la prévention d’exécution des données
1. Cliquer sur la touche Windows → touche Pause → Paramètres système avancés →

Avancés.

2. Entrer le mot de passe administrateur à l'invite.

3. Sélectionner Performance → Paramètres.
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4. Cliquer sur l'onglet Prévention de l’exécution des données et sélectionner Activer
la prévention d’exécution des données pour tous les programmes et les services.
Si le programme n'est pas dans la liste, cliquer sur Ajouter, sélectionner le
programme et cliquer sur Ouvrir.

5. Cliquer sur OK.
 La boîte de dialogue "Propriétés du système" s'ouvre.

6. Cliquer sur OK.

7. Redémarrer l'ordinateur pour activer les changements.

Numéro Explication État

0 Toujours Off La prévention de l’exécution des données est désactivée pour tous les processus.

1 Toujours On La prévention de l’exécution des données est activée pour tous les processus.

2 Opt In La prévention de l’exécution des données est activée par défaut pour les principaux
programmes et services Windows.

3 Opt Out La prévention de l’exécution des données est possible pour tous les processus, à
l'exception des programmes et des services.

Améliorations techniques
Endress+Hauser se réserve le droit d'apporter des améliorations techniques aux logiciels et
aux appareils, à tout moment et sans préavis. Si de telles améliorations n'ont aucun effet
sur le fonctionnement du logiciel, elles ne sont pas documentées. Si les améliorations ont
une incidence sur le fonctionnement, une nouvelle version du manuel de mise en service
est créée et publiée.

2.4  Sécurité informatique
Notre garantie n'est valable que si le produit est installé et utilisé comme décrit dans le
manuel de mise en service. Le produit dispose de mécanismes de sécurité pour le protéger
comtre toute modification involontaire des réglages.

Des mesures de sécurité informatique, qui assurent une protection supplémentaire du
produit et de la transmission de données associée, doivent être mises en place par les
opérateurs eux-mêmes conformément à leurs normes de sécurité.
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3  Description du produit

3.1  Fonction du logiciel
Le présent manuel de mise en service décrit la manière dont FieldCare peut être utilisé
pour établir une connexion avec des appareils HART, PROFIBUS, FOUNDATION Fieldbus,
Modbus, IO-Link et EtherNet/IP à l'aide de modems, passerelles et d'E/S distantes (Remote
I/O).

3.1.1  Gestion des licences logicielles (SLM)
Informations détaillées sur la "Gestion des licences logicielles (SLM)" : Guide de
démarrage →   7

3.1.2  Rôles utilisateur
La connexion de l'utilisateur est initialement désactivée après l'installation de
FieldCare, si bien que FieldCare peut être démarré sans avoir à se connecter.

Activation de la connexion de l'utilisateur
1. Ouvrir FieldCare Administrator →   14.

2.

Sélectionner User and User Groups → Configuration et cliquer sur User Login
active.

Rôles utilisateur
Différents rôles utilisateur sont disponibles. Chaque utilisateur peut se connecter avec un
rôle spécifique qui lui a été affecté. L'utilisateur reçoit l'autorisation pour certaines
fonctions. Ainsi, seuls les utilisateurs autorisés ont accès aux fonctions techniques et
d'exploitation. En outre, les droits peuvent être définis pour une période déterminée.

• Créer un nombre illimité d'utilisateurs
• Assigner des paramètres optionnels au compte utilisateur
• Modifier le mot de passe selon les paramètres optionnels
• Les utilisateurs peuvent changer un mot de passe
• Le mot de passe de l'utilisateur est valide pour une période spécifiée
• Désactiver le compte utilisateur si nécessaire
• Assigner à l'utilisateur un rôle conformément à la norme FDT

Rôle utilisateur Droits d'accès

Administrateur Accès illimité à toutes les fonctions, p. ex. phases de développement, de mise en
service et d'exécution dans FieldCare.

Tâches administratives, p. ex. allouer des comptes utilisateur.

Changer ou mettre à jour le catalogue DTM.

Ingénieur de planification Accès illimité à toutes les fonctions, p. ex. phases de développement, de mise en
service et d'exécution dans FieldCare.

Ingénieur de maintenance Exécution des phases de mise en service et d'exploitation autorisées.

Remplacer, étalonner et ajuster les appareils.

Écrire les paramètres dans les appareils, modifier ou lire des paramètres.



FieldCare SFE500 Description du produit

Endress+Hauser 11

Rôle utilisateur Droits d'accès

Exécution d'opérations spécifiques aux appareils en mode en ligne.

Utilisateur Exécution des phases de mise en service et d'exploitation autorisées.

Observer et gérer le processus en cours.

Contrôler l'état actuel d'un appareil.

Modifier les points de consigne afin de garantir le bon fonctionnement de l'appareil.

Observateur Observer et gérer le processus en cours.

Lire les paramètres de l'appareil et documenter les appareils connectés.

3.2  Domaine d'application
FieldCare est l'outil universel destiné à la configuration et à la gestion d'appareils de terrain
intelligents. Il permet la configuration simple des appareils, ainsi qu'une gestion simplifiée
de la maintenance, de la maintenance conditionnelle et du cycle de vie. Il peut être adapté
à différents besoins selon la licence, et peut, par conséquent, être mis à niveau à tout
moment.
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4  Montage
Informations détaillées sur l'"Installation" : Guide de démarrage →   7
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5  Fonctionnement

5.1  Démarrer FieldCare.
‣

Ouvrir FieldCare.
 FieldCare s'ouvre.

5.2  Lier FieldCare au portail W@M.
Exigences pour la connexion de FieldCare et du portail W@M :
• FieldCare/FieldCare Administration et W@M doivent être installés
• W@M typiquement installé sur un serveur
• FieldCare/FieldCare Administration typiquement installé sur un PC
• Conclure un contrat Portail W@M et créer des comptes utilisateurs
• Créer un utilisateur et un mot de passe dans le portail W@M

5.2.1  Effectuer les réglages dans FieldCare.
1. Démarrer FieldCare→   13.

2. Fermer la boîte de dialogue "FieldCare".
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3. Cliquer sur Extras → Options.
 La boîte de dialogue "Options" s'ouvre.

4. Cliquer sur l'onglet "W@M".
 L'onglet W@M est affiché.

5. Cocher la case Enabled et sélectionner Serial Number (default).
 Les appareils sont identifiés par leur numéro de série entre le portail W@M et

FieldCare.

5.2.2  Effectuer les réglages dans FieldCare Administration.
Fermer FieldCare avant de démarrer FieldCare Administration.
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1.

Ouvrir FieldCare Administration.
 La boîte de dialogue "FieldCare Administrator Login" s'ouvre.

2. Entrer Administrator comme nom d'utilisateur et Admin comme mot de passe, puis
cliquer sur Login.
 La boîte de dialogue "FieldCare Admin" s'ouvre.
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3. Sélectionner W@M Configuration.
 La vue "W@M Configuration" s'ouvre.

4. Sélectionner W@M Portal URL, puis cliquer sur Apply.

5. Sélectionner user.
 La vue "User" s'ouvre.

6. Cliquer avec le bouton droit sur Administrator → Properties.
 La boîte de dialogue "User Properties" s'ouvre.
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7. Cliquer sur l'onglet W@M.
 L'onglet "W@M" s'ouvre.

8. Entrer le User Name et le Password, puis cliquer sur OK.
 La boîte de dialogue "User Properties" se ferme.

9. Fermer Windows Explorer.
 La connexion avec FieldCare est établie pour l'administrateur.

Fonctions W@M
1. Cliquer avec le bouton droit sur un appareil.



2. Cliquer sur Device in Web → Show device specific details.
 Un test de connectivité est effectué avec W@M.

3. Cliquer avec le bouton droit sur un appareil.

4. Cliquer sur Documentation.
 Toutes les fonctions W@M disponibles sont appelées.

FieldCare fournit plusieurs fonctions pour la synchronisation des données de FieldCare
avec W@M Enterprise :
• Téléchargement de la configuration des paramètres hors ligne vers W@M
• Téléchargement de la configuration des paramètres en ligne vers W@M
• Comparaison des configurations de paramètres en ligne et hors ligne
• Comparaison de la configuration de paramètres hors ligne et historique
• Comparaison de la configuration de paramètres en ligne et historique
• Comparaison des configurations de paramètres historiques

5.2.3  Intégration de la fonctionnalité Heartbeat Verification dans le
portail W@M

1. Effectuer les réglages dans FieldCare→   13.

2. Effectuer les réglages dans FieldCare Administration→   14.
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3. Sélectionner W@M Configuration.
 La fenêtre de dialogue "Connection" s'ouvre.

4. Entrer le numéro de contrat W@M et cliquer sur Apply.

L'utilisateur reçoit un numéro de contrat W@M en en faisant la demande via le portail
W@M.

5.3  Interface utilisateur

 1 Boîte de dialogue principaleFieldCare

1 Vue Installation
2 Vue Réseau
3 Barre de menus
4 Barre d'outils
5 Vue DTM/paramètres
6 Boîtes de dialogue optionnelles
7 Barre d'état

5.4  Configuration générale

5.4.1  Paramètres du projet
1. Dans FieldCare, cliquer sur Extras → Options.
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2. Cliquer sur l'onglet Project.
 L'onglet "Project" s'ouvre.

3. Sélectionner Prompt for project at start-up et cliquer sur OK.
 La boîte de dialogue Project est affichée à chaque fois que le programme est

démarré.

5.4.2  Paramètres de scrutation ("scanning")
1. Dans FieldCare, cliquer sur Extras → Options.

2. Cliquer sur l'onglet Scanning.
 L'onglet "Scanning" s'ouvre.

3. Cocher la case à côté de Connect after scanning if only one device is found and
automatically open the DTM in the Online window, puis cliquer sur OK.
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Une fois le réseau configuré, le résultat de l'analyse s'affiche.

Après la scrutation, si FieldCare ne trouve qu'un seul appareil, une connexion
automatique est établie avec le DTM et il est commuté en ligne. Si plusieurs appareils
ont été trouvés, chaque DTM doit être connecté séparément. En fonction du DTM, un
double-clic sur un appareil non connecté déclenche également la connexion. Si ce n'est
pas le cas, l'option Connect doit être utilisée. La configuration d'appareils individuels
n'est pas décrite dans le présent manuel de mise en service. Ces informations peuvent
être trouvées dans le manuel de mise en service relatif à l'appareil concerné.

Par défaut, FieldCare utilise les interfaces FDT 1.2 pour effectuer une scrutation. Si
l'option "Prefer FDT 1.2.1 scan" est activée, les options de scrutation FDT 1.2.1 peuvent
être utilisées comme alternative.

FDT 1.2.1 peut offrir des avantages en termes de vitesse lors de la scrutation avec les
propres DTM de communication/passerelle.

5.4.3  Vue Installation
Les modifications apportées à la vue Réseau sont automatiquement synchronisées
avec la vue Installation. Les modifications manuelles apportées à la vue Installation
n'affectent pas la vue Réseau. Il est ainsi possible de concevoir une installation
indépendamment de la topologie du réseau.

Ajout d'un nouveau niveau
1. Cliquer avec le bouton droit sur un élément.

2. Cliquer sur Plant View → Add Plant Level.
 Un nouveau niveau d'installation peut être sélectionné.

 2 Structure de la vue Installation

Niveau d'installation Description

Entreprise Ne créer qu'une seule entrée de ce type dans le niveau supérieur 0.

Site
Zone
Cellule de process
Unité

Créer au niveau 1.

Zone
Cellule de process
Unité

Créer sous le type "Site".

Cellule de process
Unité

Créer sous le type "Zone".
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Niveau d'installation Description

Unité Créer sous le type "Cellule de process".

Appareil d'analyse
Appareil numérique
Pression
Spécial
Débitmètre
Niveau
Appareil de température
Vanne
Appareil inconnu

Créer sous le type "Unité".

Position Modifier l'élément ultérieurement avec Change software.

 Ceci n'est plus possible rétrospectivement pour tous les autres types. Dans ce
cas, le type doit être supprimé et un nouveau type doit être créé.

 Une entrée peut être liée logiquement à un appareil dans la vue Réseau à l'aide de la fonction Assign.
Supprimer le lien à l'aide de Unassign Device.
Les textes de légende de toutes les entrées peuvent être modifiés ultérieurement.
Une note peut être saisie pour chaque entrée via le menu contextuel, ou chaque entrée peut être liée à un
fichier ou à l'URL d'un site Web.

La vue Réseau doit d'abord être créée avant que la vue Installation ne puisse être créée. La
vue Installation correspond à la topologie réelle de l'installation ; la vue technologique est
une représentation hiérarchique du process de production. Tout utilisateur ayant le rôle
d'"ingénieur de planification" ou un rôle supérieur peut créer de nouvelles vues Installation
ou modifier des vues existantes.

Les éléments peuvent être déplacés dans la vue Installation. Les éléments de la vue
Installation peuvent être renommés, ajoutés ou supprimés.

Colonne Utilisation

TAG installation Repère pour chaque position de l'installation.

Connexions Symbole indiquant l'état en ligne/hors ligne.

État Indique l'état de diagnostic actuel.

Surveillé Option permettant d'activer la surveillance de l'appareil courant via l'application
Condition Monitoring.

Critique Option permettant de spécifier si l'appareil est un appareil critique.

Voie Indique la voie via laquelle l'appareil est connecté.

Adresse Indique l'adresse de l'appareil qui est assigné à cette position d'installation.

Type d'appareil (DTM) Indique le type de l'appareil.

Appareil physique Identifie l'appareil physique sur un point particulier du réseau.

5.4.4  Vue Réseau
La vue Réseau est une représentation graphique du réseau d'appareils appartenant à un
projet FieldCare.

Colonne Utilisation

TAG réseau Repère réseau de l'appareil.

Connexions Symbole indiquant l'état en ligne/hors ligne.

Voie Indique la voie via laquelle l'appareil est connecté.

Adresse Adresse réseau unique de l'appareil.

Type d'appareil (DTM) Indique le type de chacun des appareils individuels.

Appareil physique Identifie l'appareil physique sur un point particulier du réseau.
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5.5  Fonctions générales
Vue Installation/Réseau
• Via le menu contextuel → Customize Plant View
• Boîte de dialogue d'affichage
• Afficher/masquer les colonnes
• Ajuster l'ordre des colonnes

Fonction liste
• Ajuster pour que les listes soient triées en fonction de l'en-tête de colonne
• Changer la largeur de colonne
• Changer l'ordre des colonnes à l'aide de "Copier" et "Coller"

5.6  Vérification du réseau
La topologie du réseau dans FieldCare peut être comparée par rapport au réseau physique
actuel. Ceci est particulièrement utile si un appareil est ajouté à un réseau existant. Un
projet peut être préparé hors ligne, puis téléchargé via FieldCare. De cette façon, il est
possible de vérifier la topologie actuelle du réseau et la topologie physique pour y apporter
les modifications nécessaires.

Avant de procéder à la vérification du réseau, il est à noter que seuls sont vérifiés les
réseaux pour les appareils de communication possédant au moins un DTM. Dans le
cas contraire, l'option de menu Verify Network est désactivée.

Vérification du réseau
1. Dans la vue Réseau, sélectionner un appareil avec au moins un DTM.

2. Cliquer sur Verify network  dans la barre d'outils.
 La boîte de dialogue "Communication channel" s'ouvre.

3. Sélectionner la voie désirée et cliquer sur OK.
 FieldCare analyse la voie souhaitée.

Lorsque le réseau a été vérifié, la boîte de dialogue "Scanning Result" s'ouvre.
Une liste des appareils joignables est affichée dans la colonne Status, indiquant
dans quelle mesure les appareils de la topologie planifiée s'intègrent dans la
topologie réelle.
Il existe cinq états différents au total :
Les types d'appareil et les numéros de série sont identiques.
Les types d'appareil sont identiques.
Les types d'appareil sont différents.
Un nouvel appareil a été trouvé.
Appareil inattendu dans le projet.

4. Des modifications peuvent être effectuées dans le menu contextuel de l'appareil
concerné. Lire/écrire les données d'appareil ou remplacer le type d'appareil.
Cliquer sur OK pour confirmer les modifications.
 Les modifications sont enregistrées.
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6  Intégration système

6.1  Réglage d'une adresse IP
• Les droits d'administrateur sont requis
• La description s'applique à Windows 7

Tous les appareils Endress+Hauser pourvus d'une interface Ethernet sont livrés avec une
adresse IP par défaut, p. ex. l'adresse IP pour la Fieldgate FXA720 est 192.168.253.1. Pour
que l'ordinateur hôte puisse communiquer avec le serveur Web de la Fieldgate FXA720, il
doit se voir attribuer une adresse IP dans le même domaine d'adresses, p. ex.
192.168.253.99. Pour plus d'informations, contacter l'administrateur réseau.

Réglage de l'adresse IP de l'ordinateur
1. Cliquer sur Démarrer → Panneau de configuration → Réseau et Internet → Centre

Réseau et partage.
 La boîte de dialogue "Connexions réseau" s'ouvre.

2. Cliquer sur Gérer les connexions réseau.

3. Cliquer avec le bouton droit sur les connexions devant être modifiées.

4. Si nécessaire :
Entrer le (mot de passe administrateur ou la confirmation).

5. Cliquer avec le bouton droit sur l'onglet Réseau.

6. Cliquer sur Protocole Internet version 4 (TCP/IPv4) dans l'entrée "Cette connexion
utilise les éléments suivants".

7. Cliquer sur Propriétés.

8. Noter les valeurs d'origine de l'adresse IP et du masque de sous-réseau de l'ordinateur
pour les restaurer si nécessaire à la fin de l'opération. Un ordinateur utilisé dans un
réseau d'entreprise obtiendra automatiquement son adresse.
Cliquer sur Utiliser les adresses IP suivantes.

9. Entrer l'adresse IP, le masque de sous-réseau et la passerelle par défaut pour
"TCP/IPv4".
 Les réglages pour l'adresse IP sont acceptés.

10. Cliquer sur OK.
 La procédure est terminée.

6.2  Pare-feu Windows
Si des pare-feu sont utilisés sur les ordinateurs sur lesquels résident les serveurs et les
clients, ils doivent être programmés pour permettre un accès mutuel. Comme la
configuration du pare-feu est souvent une question de stratégie de sécurité
informatique de l'entreprise, il faut consulter l'administrateur système avant de
procéder. De plus, des droits d'administration sont requis pour effectuer cette tâche.

Les ports disponibles pour la Fieldgate SFG500 sont listés dans le tableau ci-dessous :

Numéro de port ID

TCP 60010 TCP_PCPS2_SFG500_PORT

UDP 60015 UDP_IDENTIFY_PORT

UDP 60020 UDP_ANNUNC_PORT
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Gestion du pare-feu Windows
1. Appuyer sur Démarrer → Panneau de configuration → Pare-feu Windows.

2. Dans le volet de gauche, cliquer sur Autoriser un programme via le pare-feu
Windows.

3. Si nécessaire :
Entrer le mot de passe administrateur.

4. Cocher la case à côté du programme devant être autorisé, puis cliquer sur OK.

5. Dans le volet de gauche, cliquer sur Paramètres avancés.

6. Si nécessaire :
Entrer le mot de passe administrateur.

7. Dans la boîte de dialogue "Pare-feu Windows avec sécurité avancée", cliquer sur
Règles de trafic entrant.

8. Dans le volet de gauche, cliquer sur Nouvelle règle.

9. Suivre les instructions dans l'Assistant Nouvelle règle de trafic entrant.

10. Aller à l'onglet Exceptions.
 Deux niveaux principaux s'ouvrent. Les exceptions peuvent être ajoutées sur ces

niveaux.
"Ajouter un programme" spécifie les applications qui sont capables de répondre à
des requêtes non sollicitées.
"Ajouter un port" spécifie que le pare-feu doit autoriser le trafic TCP sur les ports
utilisés par les serveurs.

11. Sur l'onglet "Général", cocher la case Activé (recommandé).

Le pare-feu est à présent actif.



FieldCare SFE500 Configuration

Endress+Hauser 25

7  Configuration
Les données relatives au projet sont enregistrées dans une base de données ou dans des
fichiers, selon le mode de stockage du projet.

7.1  Réglage de la langue d'interface
1. Ouvrir FieldCare.

2. Cliquer sur Extras → Options.
 La boîte de dialogue "Options" s'ouvre.

3. Sélectionner la langue requise dans l'onglet "Display", puis cliquer sur OK.
 La langue est enregistrée et disponible la prochaine fois que le programme est

démarré.

7.2  Création d'un projet
Les premières étapes de la création d'un projet sont toujours identiques. La boîte de
dialogue FieldCare apparaît par défaut ; ceci peut être désactivé sous Extras →
Options → Project. La boîte de dialogue FieldCare n'est plus affichée si la case None
est cochée.



Configuration FieldCare SFE500

26 Endress+Hauser

Création d'un projet
1. Ouvrir FieldCare.

 La boîte de dialogue "FieldCare" s'ouvre.

2. Sur l'onglet "New", sélectionner l'élément Create Project et cliquer sur Open.
 FieldCare ouvre un nouveau projet avec un PC hôte.

7.3  Enregistrement d'un projet
Les projets FieldCare sont stockés dans une base de données mais ne sont pas
accessibles sous forme de fichiers sur le disque dur. Il est possible d'accéder à ces
fichiers en utilisant FieldCare en mode fichier. Tous les projets sont enregistrés de la
même manière.
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Enregistrement d'un projet
1. Sélectionner File → Save As.

 La boîte de dialogue Save Project As s'ouvre.

2. Entrer un nom de projet et cliquer sur Save.
 Le projet est enregistré.

7.4  Ouverture d'un projet enregistré
Ouverture d'un projet enregistré
1. Dans la boîte de dialogue FieldCare, cliquer sur l'onglet Existing.

 La boîte de dialogue "Open Project" s'ouvre. Les derniers projets ouverts sont
affichés.

2. Sélectionner Project et cliquer sur Open.
 Le projet est affiché.

Si le projet n'apparaît pas à l'écran, cliquer sur View → Network.

7.5  Exportation et importation CSV
Les informations structurelles de la vue Installation et de la vue Réseau (topologie de
l'installation/du réseau) peuvent être exportées vers un fichier CSV et importées depuis un
fichier CSV vers un projet FieldCare.
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Importation d'un fichier CSV
1. Créer un projet. →   25

2. Cliquer sur File → Import/Export → Import CSV file.
 La boîte de dialogue "Import CSV file" s'ouvre.

3. Sélectionner un fichier et cliquer sur Open.
 Les données du fichier CSV sont importées en vue Installation et/ou en vue

Réseau.

Exportation d'un fichier CSV
1. Sélectionner un projet.

2. Cliquer sur File → Import/Export → Export CSV file.
 La boîte de dialogue "Exported topology" s'ouvre.

3. Cliquer sur Export.

4. Sélectionner un emplacement de stockage et un nom, puis cliquer sur Save.
 La vue Réseau est exportée vers un fichier CSV.

7.6  Information DTM
La boîte de dialogue Information contient un résumé de toutes les informations DTM
pertinentes.

Affichage de l'information DTM
1. Cliquer sur Device catalog dans la barre de menus.

2. Cliquer sur Display.
 Le catalogue d'appareils s'ouvre.

3. Cliquer avec le bouton droit sur un DTM.

4. Cliquer sur DTM Information.
 La boîte de dialogue "Information" s'ouvre.

Options possibles dans la boîte de dialogue "Information"
• Affiche les informations de base de tous les types d'appareil pris en charge par le DTM
• Affiche l'information DTM :

• ID fabricant
• ID type d'appareil
• ID type d'appareil secondaire
• Information type appareil
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7.7  Affichage du catalogue d'appareils
La boîte de dialogue Device catalog contient la liste de tous les DTM et packs FDI qui se
trouvent actuellement dans le système de gestion des appareils. Les DTM peuvent être
groupés par catégorie, fabricant ou protocole.

1. Cliquer sur Device catalog dans la barre de menus.

2. Cliquer sur Display.
 Le catalogue d'appareils s'ouvre.

7.8  Mise à jour du catalogue d'appareils
Informations détaillées sur la Mise à jour du catalogue d'appareils : Guide de
démarrage →   7
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8  Diagnostic et résolution des problèmes

8.1  Résolution des problèmes généraux

Problème Solution

FieldCare SQL Server ne
démarre pas.

Démarrer SQL Server manuellement :
• Démarrer Windows et entrer services.msc dans le champ de recherche.
• Sélectionner SQL Server (SQLFIELDCARE).
• Cliquer sur Démarrer.

Macros d'analyse
manquantes.

Importer les macros :
• Dans le dossier "...\Endress+Hauser\FieldCare\db", importer le fichier

ImportScanningMacros.cmd.
• Ensuite, redémarrer FieldCare.

Entrées de menu en
double ou fenêtres
manquantes.

Réinitialiser la mise en page :
• Fermer FieldCare.
• Dans le dossier "...\Endress+Hauser\FieldCare\Profiles", supprimer le fichier

profile.xml.

Catalogue d'appareils
défectueux.

Réinitialiser le catalogue d'appareils FieldCare :
• Fermer FieldCare.
• Dans le dossier "...\Endress+Hauser\FieldCare\Frame", supprimer le fichier

FRMRepository.xml.
• Redémarrer FieldCare et mettre à jour le catalogue d'appareils.

En cas de problèmes additionnels, contacter Endress+Hauser :
www.addresses.endress.com
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9  Mises à jour du logiciel
Informations détaillées sur la "Mise à jour du logiciel" : Guide de démarrage →   7
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